IT Training

Microsoft Office 2013™
The Drawing Tools (Level 2)
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Introduction
Microsoft Draw allows you to produce your own drawings (or edit existing ones) and is
available to you in all the Microsoft Office programs (except Access - though you can copy a
drawing created in one of the other applications onto an Access form). You cannot load
Microsoft Draw independently; it is provided as part of the other software packages.

This document is designed to cover the features available to you when you use Draw in any of the Microsoft
Office programs. Slight variations exist between the products (for example, Word has text wrapping effects,
while PowerPoint provides Action Buttons). These variations are not covered here.
Note that drawings and pictures are fundamentally different. Drawings are composed of lines and areas,
whereas a picture is a fine grid of coloured dots (a bitmap). If you paste a drawing into a painting program, its
component units (the lines etc) are lost - they become a series of individual dots. To create a picture you
need to use a painting package such as Microsoft Paint (see A Guide to Microsoft Paint for details).
1. Start by loading up the required Microsoft Office application – here use Microsoft PowerPoint
2. [Maximize] the window to make full use of the screen
3. Click on the [Layout] button in the Slides group on the HOME tab of the Ribbon and select Blank

Activating the Drawing Tools
To activate the Drawing Tools you simply have to use one. When you do,
the Drawing Tools Format tab is added to the Ribbon.
1. Move to the INSERT tab and, in the Illustrations group, click on
[Shapes] (in PowerPoint this button is also on the Home tab)
– a drop-down list appears, as shown on the right
As you can see, there are a host of different shapes to choose from, split
into several groups. The first group, called Recently Used Shapes, contains
the basic shapes – a text box, line, arrowed line, rectangle/square and
oval/circle. You will be trying these out first. There are further basic shapes
in this group (eg a triangle, connector, block arrow, star etc) which will be
dealt with later. Further groups (Lines, Rectangles, Basic Shapes etc) give
you access to even more sophisticated drawing tools.
Let’s start with a simple line:
2. Click on [Line] - the second (or third) of the buttons
3. Move the mouse cursor to where you would like to draw a line on
the slide then hold down the left mouse button and move the
mouse
4. As the mouse is moved an elastic line appears, starting at the
position where you first held down the mouse button and ending at
the current position of the mouse cursor
5. Position the mouse cursor where you want the line to end then
release the mouse button - a line with small circles (handles) at
each end appears (you will learn about handles later)
The same principal works with the next three tools on the Drawing toolbar:
6. Click on the (next) [Arrow] button
7. Repeat steps 3 to 5 - the arrow head appears at the end of the line (step 5)
8. Click on the (next) [Rectangle] button
9. Repeat steps 3 to 5 - this time an elastic rectangle appears (it's filled with blue in Word/PowerPoint but
has no fill colour in the other Office programs)
10. Finally click on the (next) [Oval] button and repeat steps 3 to 5
If you want to draw a square or circle, hold down the <Shift> key as you drag out the shape:
11. Click on either the [Rectangle] or [Oval] button, hold down <Shift> and draw a square or circle
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The first button in this group is for text. A text box can be completely independent or can be associated with
an area object such as a rectangle or oval.
12. Click on the (first) [Text Box] button then point the mouse cursor to where you want the text to
appear and click the mouse button
A box appears with a flashing cursor in it indicating the typing position (in Excel/PowerPoint it's a small box
which grows as you type; in Word you get a fixed 1 inch square). You can create a bigger box by dragging out
a rectangle. In Word only, a Text Box Tools tab is added to the Ribbon.
13. Type some words into the text box - note that you can press <Enter> for a new paragraph
14. Click away from the text box when you have finished typing
Note: The text can be rotated. In Word, this is done using the [Text Direction] button on the TEXT BOX TOOLS
tab. In PowerPoint, the [Text Direction] button is in the Paragraph group. PowerPoint also lets you freely
rotate text to any angle using the green rotation handle which appears when a text box is selected.
To add some text to an object (eg a rectangle or oval):
15. Right click on the rectangle you drew previously and choose Add/Edit Text
16. Type in your text – this wraps around within the object (you’ll see later how to enlarge it, if necessary)
17. Set the text direction, if required, then click away when you've finished

Editing Drawing Objects
Once you've drawn an object you can change its size, shape and colour. It's generally easier to make such
changes after you've drawn the object but you can set up colours, line styles etc before you begin to draw it, if
you prefer. You can also move it or delete an object.
You will probably have noticed the little circles which surround an object when you draw it. Lines have a
small circle at each end; rectangles, ovals and text boxes have circles at each corner and mid-way along each
side. These circles are known as handles and are the key to editing. The green circle on the top of some
objects is used for rotation, as you will see later.

Changing the Size/Shape of an Object
To change the size or shape of an object:
1. Click once on the object to select it (try an oval first) - the handles should appear
2. Move the mouse pointer over a corner handle (the opposite corner will become the fixed position)
and note how the cursor becomes a double-headed arrow
3. Hold down the mouse button (the cursor becomes a plain cross) and move the mouse around
4. Release the mouse button when the shape is as required
By using a corner handle, you can change the oval both horizontally and vertically. If you use a side handle, you
can only resize in one direction. Again, holding down <Shift> preserves the shape.
5. Repeat steps 2 to 4 using a side handle
Next try resizing a line/arrow. Selecting a two-dimensional shape isn't quite so easy - you have to place the
mouse cursor in exactly the right place before you click the mouse button. You can tell when it’s correct
because a four-headed cross is added to the pointer.
Tip: You can also use the <Tab> key to move between and select objects.
6. Move the mouse cursor over a line/arrow until the cross appears (ie anywhere on the line)
7. Click on the mouse button to select the line/arrow
8. Point to an end handle, hold down the mouse button and drag the mouse around
9. Release the mouse button when the line/arrow is correctly resized and angled
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Tip: If you hold down <Ctrl> as you resize a 2-D object, the centre of the object remains fixed.

Changing the Colour of an Object
You can set up the colour of a line and infill of an area object by first selecting it and then clicking on the
[Shape Outline] or [Shape Fill] button on the Drawing Toold Format tab:
1. With the line/arrow still selected, click on the list arrow attached to the [Shape Outline] button
2. Choose the required colour (you can use a Theme colour or Standard colour or can choose your own
colour - here choose More Outline Colors... and select from the Standard palette of 128 colours)
You can even get multi-coloured lines though these are more usually used to fill an area, as you’ll see next:
3. Click on a rectangle or oval to select it
4. Set the line colour as in steps 1 and 2 above (if you don't want a line at all choose No Line)
5. Click on the list arrow attached to the [Shape Fill] button and select a colour from the palette - or
choose your own colour using More Fill Colors...
As well as a Solid Colour you can choose a Gradient (in one or more colours), a Texture (eg wood or marble) or
can even use a picture held in a file. To see these:
6. Repeat step 5 but select Texture and choose from one of the standard textures
7. Repeat step 5 again but this time choose Gradient and select one of the many variants
8. Repeat step 7 but choose More Gradients… - a Format Shape task pane appears on the right

In fact the same pane would have appeared had you chosen More Textures… at step 6. You can also display
it by clicking on the Shape Styles group arrow.
9. Click on Preset gradients and choose a different gradient
10. Click on Type: and explore the different options (note, the Angle: option only works for Linear)
11. Click on Direction: and explore the settings here
12. Finally, drag the Gradient stops around to see what happens – the buttons on the right add/remove a
stop and each stop can have Color, Position, Transparency and Brightness settings
You can copy the colour scheme of one object to another using the Format Painter. Try this next:
13. Click on the [Format Painter] button (the little brush on the left of the HOME tab
14. Click on one of the other objects to colour it the same as the original
15. Press <Ctrl z> or click on [Undo] to restore the original colour
16. End by moving back to the DRAWING TOOLS FORMAT tab
4

Changing Text Box Settings
In addition to being able to set a fill and line colour, you can choose the colour you want for text inside a Text
Box. In fact you have the full range of formatting available to you - eg font and font size, style, justification,
spacing, numbering, highlight, bold/italic etc.
1. Drag though some of the text in one of your text boxes
2. Right click and choose [Bold] (or press <Ctrl b>
3. Repeat step 2, changing the [Font] (eg to Symbol) and [Font Size] (eg to 28)
4. Click on the text, to release the selection, then press <Esc> to selects the box itself
5. Use the [Text Fill] button to change the colour of your words, if you want to
6. Click on the [Shape Fill] button and select No Fill or a background colour if you want one
7. Click on the [Shape Outline] button and select No Outline to hide it
8. Finally, set the required alignment - in PowerPoint, the default is Centred
One other feature of a Text Box is the inner margin between the text itself and the edge of the box. To set this,
the Format Text Box pane must be displayed:
9. In the Format Shape pane on the right, click on [Size & Properties] – the last of the three buttons:

10. Set all four Text Box Margins to 0 if you want the text right up to the edge
11. Set Autofit to Resize shape to fit text
Note how the text goes right up to the edge of the box, which has been shrunk to fit it. If the box is too wide:
12. Open up the Size settings in the Format Shape task pane
13. Change the Width as required

Changing Line/Arrow Styles
When you drew a line or arrow, the default line style (thickness etc), dash style (for broken lines) and arrow
style (for different arrow points etc) was used. You can set these up before drawing the line/arrow, if you
want, or can apply a style to an existing line.
1. Click on the simple line you have already drawn to select it then click on the [Shape Outline] button
2. Choose Weight and make the existing line slightly thicker by selecting 3pt
3. Repeat step 1 but choose Dashes and select one of the styles provided
4. Finally repeat step 1 but choose Arrows
5. Currently, the line doesn't have an arrow - choose any of the styles to add one to the line
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The complete selection of line settings can be seen by opening up the Line settings in the task pane (this is
also displayed if you select More Arrows... or More Lines... under Weight or Dashes):
6. Open up the Line settings in the Format Shape task pane:

7. Color lets you choose the line colour
8. Transparency allows you to see other objects behind the line
9. Width: allows you to set your own width – use the arrows to change the width of your line
10. Compound type: allows you to choose multiple lines
11. Dash type: offers nothing new but Cap type: lets you choose a rounded end for your line
12. Join type: lets you choose rounded objects where two lines meet (eg the corner of a rectangle)
13. The Arrow settings let you choose the size and shape of both ends of the line - explore what's
available here and change some of the settings

Moving an Object
To move an object:
1. Move the mouse cursor over the object until the cursor becomes a four-headed cross
2. Hold down the mouse button and drag the object around
3. Release the mouse button when the object is correctly positioned
You can also move objects using the arrow keys:
4. Click on an object to select it (for a text box, click inside then press <Esc>)
5. Press the <arrow keys> to move the object until it is correctly positioned
Note that when one object overlaps another, all or part of one of them may disappear. You will learn later
how to change this.

Deleting an Object
To delete an object:
1. Click on the object to display the handles (for a text box, click inside then press <Esc>)
2. Press the <Delete> or <Backspace> key
You can also remove an object by right clicking and choosing Cut from the pop-up menu. Here, to reverse the
deletion:
3. Press <Ctrl z> or click on the [Undo] button
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Understanding the Grid
A drawing can be made on a grid (like drawing on graph paper). This is particularly useful for accurate (scale)
drawing. The grid is usually hidden but can be displayed as below:
1. On the View tab, turn on [Gridlines] – the gridlines are shown (by dots in PowerPoint)
2. Also turn on the [Ruler] if you want to draw with accuracy
3. Use Zoom control in the bottom right corner of the screen and set it to between 200% and 300%
4. Try moving an object (drag it or use the arrow keys) and note it moves
To display the grid:
5. In PowerPoint, click on the Grid Settings group arrow (to the right of the Show group label):
In Word, click on the [Align] button in the Arrange group and choose Grid Settings:

Powerpoint:

Word

:

6. Here, turn on Snap objects to grid then press <Enter> for [OK]
7. Try resizing an object (or drawing a new one) and note how it is linked to the grid
8. Use the [Height] and [Width] buttons in the Size group to set an accurate dimension
You can temporarily turn off the grid by using either the <Alt> key (when resizing, drawing or moving) or
<Ctrl> key (when moving an object using the arrow keys):
9. Hold down the <Alt> key and resize it using one of the handles - you will find the size no longer
changes in jumps
10. Hold down <Alt> and try moving an object using the mouse - again it moves smoothly
11. Next, hold down <Ctrl> and use the arrow keys to move the object (you'll find you need to press the
key several times to move it by a single grid square)
12. Finally. hold down <Ctrl> and move an object with the mouse – you’ll find you get a copy
Remember: When dragging an object, you have to use <Alt> not <Ctrl>.
You can change the spacing of the gridlines and set new default values, if you want.
13. Repeat step 5 to display the available settings
14. Change the Grid settings if you want to then press <Enter> for [OK]
15. Test out the new grid by repeating some of the steps above
16. Turn off the gridlines and snap to grid (steps 1 and 5 to 6 above)
17. Reset Zoom to 100% (or less) so that you can see the whole of the drawing
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Aligning and Distributing Objects
One thing you may require is to align and/or evenly space objects. Having snap objects to grid on helps with
this as you can see by eye when objects are lined up and correctly spaced. If you aren't using the grid,
however, this task can become very difficult. To help you, commands are provided which do this precisely:
1. Select one of your objects (eg an oval) by clicking on it
2. Hold down <Ctrl> and drag the object twice to get three identical objects (or use Copy and Paste)
If you Copy/Paste, the new objects are positioned one grid line apart, both horizontally and vertically.
3. Move the objects so that they are roughly in a line and some distance apart
The red lines which appear are a new feature and are to help you line up objects, but ignore them here
4. Select all three objects by holding down the <Shift> key and clicking on them – the handles appear
This is the way to select more than one object at a time. You can unselect a particular selected object by
clicking on it a second time (while still holding down <Shift>).
5. Now click on [Align] to and select Align Top - the objects are lined up with the top of the highest one
6. Repeat step 5 but this time select Distribute Horizontally - the objects will now all be evenly spaced
Tip: In PowerPoint, you can also select a group of objects by holding down the mouse button and dragging a
rectangle to enclose them.

Grouping/Ungrouping Objects
As you gradually build up your drawing, it's useful to be able to group component parts together. You can
then move, resize, colour etc all of the grouped objects at a time.
1. Hold down <Shift> and click on each object in turn (or, in PowerPoint, drag out a rectangle to
surround them)
2. With the required objects selected click on [Group] and choose Group
Tip: You can also right click and choose Group.
3. Press the arrow keys to move the group of objects around
4. Resize the group of objects by dragging on one of the corner handles
5. Change the [Shape Outline] and/or [Shape Fill] to colour all the objects the same
The grouped objects act as a single object, though you can still colour them individually or move one
independently:
6. Click on one of the objects in the group to select it
7. Press an arrow key to alter its position
8. Change the [Shape Outline] and/or [Shape Fill]
You can also Ungroup and Regroup objects:
9. Click outside the group to deselect it then click on it again, this time to select it
10. Now click on [Group] and choose Ungroup
11. Make any changes required then click on [Group] and this time choose Regroup
You'll find that Draw remembers which objects were the original members of the group and will regroup
them (without you having to select them again individually). Of course, if you wanted to create a different
group you could <Shift> select the new set of objects and use a Group command.
When creating a complicated drawing, group the individual objects, as above, then start grouping the
groups.
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Changing Object Order
Another feature you will probably have noticed, particularly with areas, is that one object may wholly or
partially hide another. To overcome this you have to reset the display order of the objects. The default order
is that the newest object is placed on top of all the others. To demonstrate this and change the order:
1. Click on the [Rectangle] button and draw a large rectangle over all or most of your current objects you will find that they are hidden
2. Now click on the [Arrange] button and choose Send Backward - one of the hidden objects should
reappear
Note that Word offers two additional options here, Bring in Front of Text and Send Behind Text.
3. Repeat step 2 to reveal further objects
4. Repeat step 3 but this time choose Send to Back - all the objects should now be visible
Tip: You can also right click and choose Send to Back.
You have seen how an individual object can be moved up/down the stack of objects either one item at a time
or to the very top/bottom. An alternative strategy is to make the object transparent:
5. Right click on the rectangle and choose Bring to Front - the objects are hidden again
6. The Format Shape task pane should still be shown – if not, right click on the rectangle and choose
Format Shape
7. In the Fill settings, use the Transparency: slider and watch what happens (if this is set to 0% the colour
is solid, if it's 100% then it's equivalent to No Fill)
8. Set to Transparency: about 70%
9. Drag the rectangle around and watch how different objects are hidden or shown in full
10. End by removing the rectangle completely - press <Delete> or <Backspace>

Rotating an Object
Another command allows you to rotate an object, or make it a mirror image.
1. Click on the arrow to select it - if necessary, move it or use [Bring to Front] to see it properly
2. Click on the [Arrange] button, choose Rotate then drag through the fixed settings – as you do, the
arrow moves to reflect the highlighted option
3. Also try More Rotation Options … - the Size settings in the Format Shape task pane are shown
4. Using the arrows provided, change the angle of Rotation – again, the arrow moves as the settings are
changed
5. Try changing the Height and Width too and watch what happens
Flipping and rotating can be applied to any sort of object. In Word, you can’t rotate or flip the text in a text
box (in PowerPoint you can) but you can change the [Text Direction]. The same applies to free rotation:
6. Click on any solid shape (including the text box) to select it
7. Point the mouse cursor to the small circle which appears above centre (the cursor becomes a circular
arrow) then hold down the mouse button and drag the mouse around to rotate the object
Lines and arrows don't have this free rotate handle but they can still be rotated as you saw with the arrow at
the start of this section.
Tip: You can select several objects and rotate them all at the same time.
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Other Shapes
As well as the basic shapes you have already seen, Draw provides a host of more complex shapes including
geometric and other basic shapes, stars, callouts, flowchart objects, fancy arrows and curved lines (plus
connectors). The Line shapes are the most important and are dealt with later. As an example of creating and
modifying one of the other shapes, try drawing a block arrow:
1. Click on the [Right Arrow] button in the middle row of the [Shapes] in the Insert Shapes group
2. Position the mouse cursor where you would like the arrow to start then hold down the mouse button
and move the mouse (as if you were drawing a rectangle)
3. Release the mouse button when the arrow is the required size
Because this is a slightly more complicated shape, additional handles are provided. The yellow squares are
used to control the width of the arrow shaft and size of the arrow head.
4. Position the mouse cursor over the yellow handle on the left, hold down the mouse button and drag
the mouse up or down - release the mouse button when the shaft is the correct thickness
5. Repeat step 4 but use the other yellow handle and move the mouse left or right to set the size of the
arrow head
6. Use the normal handles to change the overall size and shape of the arrow
7. You can colour the arrow (the fill and the line) as before, if you want
Next try an even more complicated shape - a curved arrow. This isn’t one of the shapes currently showing, so:
8. Click on the [More] arrow below the scroll bar on the right of the [Shapes] to display all the shapes
9. In the Block Arrows group, select [Curved Right Arrow] - leftmost icon in the second row
10. Draw the arrow in the position required as described in steps 2 and 3
When you release the mouse button you will find three additional yellow handles are provided to manipulate
the shape. The one on the right controls the height of the arrow head, the one at the bottom the head's
width, while the third determines the width of the shaft.
11. Repeat step 6 on all three yellow handles to see exactly what they control
12. Colour the arrow and rotate it using the circle, if you like
You can try out some of the other Shapes, if you like. Watch out for the yellow handles and try moving them
to see the effect - for example, you can alter the smile on the Smiley Face under Basic Shapes or the spikiness
of a Point Star under Stars and Banners.

Drawing an Irregular Shape
One of the shapes provided under Lines is called Freeform. This allows you to draw an irregular shape (such as
a house - a rectangle plus trapezoid).
1. If using PowerPoint, press <Ctrl m> to insert a new slide - in Word Scroll down the display to draw in a
clear area
2. Move to the Insert tab of the Ribbon then click on [Shapes] and choose [Freeform] –the last but one
in the Lines group
3. Move the mouse cursor to where you want to start your object and click the mouse button
4. Move the mouse and you will find an elastic line attached (hold down <Shift> if you want more
control)
5. Click the mouse button to fix the line
6. Move the mouse again and a new elastic line appears - again, click to fix the line
7. Repeat step 6 until you complete your shape (back to the point where you started the object)
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Handles now appear round the object and the elastic line disappears. Note that you can draw multiple lines
to and from points (other than the starting position) in your object - only when you click on the start point
does the drawing end.
Tip: To draw an open object (ie where you don't want to end at the start point), double click on the mouse
when you draw the final line.
Sometimes you don't want a straight line between two points. To draw a line freehand you simply hold down
the mouse button rather than click on it. This is equivalent to the [Scribble] button, which is another option
available under the heading Lines.
8. Click on [Freeform] to start off your freeform shape – this now shows on the Drawing Tools Format tab
9. Draw a straight line then hold down the mouse button after you fix the end of the line
10. The cursor now turns into a pencil - as you move the mouse, a freehand line appears
11. Release the mouse button to end the freehand drawing
12. Continue drawing the shape, either clicking to draw straight lines or holding down the mouse button
to draw freehand
13. Complete the shape by returning to its origin (or by double clicking the mouse)

Editing an Irregular Shape
It takes quite a lot of practice to be able to draw freehand with the mouse. Even for those with poor mouse
control all is not lost, however, as you can always edit the shape to correct any mistakes:
1. Right click on the freeform shape you have just drawn and choose Edit Points
A series of points (called vertexes) now appears, some marking the end of the straight lines while others are
scattered along the freehand line. Draw fits a smoothed curve to these points, which define the line. You are
now free to move (or delete) any of these points to improve your drawing.
2. Position the mouse cursor over any of the points - it changes from a four-headed cross to a small
square with four tiny arrow heads
3. Hold down the mouse button and drag the point to where you want it
4. Use the [Zoom] slider to show finer detail
5. Repeat steps 2 and 3 to position a point exactly
6. To delete a point, right click on it and from the shortcut menu choose Delete Point
7. To add an extra point, right click on the line where you want it placed and choose Add Point
The other options here give you full control over smoothing - with, Smooth Point you are provided with
extra handles. These allow you to control the shape of the line in that area precisely.
8. End by resetting [Zoom] to its original level

Drawing a Curve
The other type of line you can draw is a curve. A simple curve is defined by three anchor points; further points
define a polynomial.
1. Begin by creating a new drawing (if using PowerPoint, press <Ctrl m> to insert a new slide - in Word
Scroll down the display to draw in a clear area)
2. Move to the Insert tab, click on [Shapes] then, in the Lines group, on [Curve] - left of [Freeform]
3. Position the cursor where you would like the curve to begin then click the mouse button
4. Move the cursor to roughly the mid-point of the curve and click the mouse button again
5. Finally, move the cursor to where you want the curve to end (an elastic curved line is displayed) and
double click on the mouse button to complete the curve
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You can now edit the curve to get the precise shape you require:
6. Right click on the curve and choose Edit Points
7. Move the mouse pointer over the middle vertex, hold down the mouse button and drag the point to
alter the shape of the curve
8. Repeat step 6 on an end vertex to stretch out or alter the end position
9. Click away from the curve to switch off the edit points
To draw a polynomial:
10. Repeat steps 1 to 3 as above
11. Keep clicking on the mouse button to set further points along the curve
12. Double click on the mouse or close the curve (by clicking at the start point) to end drawing

Shape Effects
Another whole group of drawing tools can be found via the [Shape Effects] button in the Drawing Tools
Format tab. These include Shadow, Reflection, Glow, Bevel and 3-D Rotation.
1. Draw a new [Rectangle] in the bottom left corner of the current slide (or screen area)
2. Click on the [Shape Effects] button in the WordArt Styles group to see the different categories
You also have access to these controls in the Format Shape task pane. To see these:
3. Click on the [Effects] button – the middle one of the three provide

Adding Shadows and Reflections
To add a shadow to an object (or change a preset one):
1. Select the object then open up Shadow or Reflection in the Format Shape task pane:

2. Choose any of the Presets: to activate the other settings
3. Amend the current settings, as required
Explore Glow and Soft Edges, if you like, though they aren’t that interesting.
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3-D Effects
To customise a 3-D Effect:
1. Select the object then open up 3-D Format in the task pane

2. Try altering some of the settings to see what happens – eg increase the Depth: significantly and, under
the Surface heading select different Material: and Lighting: settings
Next, look at the 3-D Rotation settings:
3. Open up 3-D Rotation in the task pane:

4. Use the spin buttons on the right of the Rotation settings and watch what happens
5. Click on [Reset] if you want to return the object to its original settings
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WordArt
Another feature available to you in Microsoft Office is WordArt. This lets you type in text in a wide variety of
layouts such as in a curve, using outlined letters or with a shadow. To see what's available:
1. Start by moving to a clean area (in PowerPoint, press <Ctrl m> for a new slide)
2. On the Insert tab, click on [WordArt] and choose anything from the selection provided
3. In the box which appears, type in some text (eg your name)
You have access to all the effects explored above via the task pane but also:
4. Click on [Text Effects] and choose Transform – your text can now appear in a curve or whole host of
other shapes – watch what happens as you move the mouse cursor over them
5. Select one of the shapes then change some of the settings via the Format Shape task pane
The WordArt provided in Microsoft Word works slightly differently. Here, you have a WordArt Gallery and other
settings to change the text spacing, height etc. If you need these facilities you can always create your
WordArt in Word and then Copy and Paste it into PowerPoint.
This brief introduction to WordArt should have made you aware of some of the features available. It's
particularly useful for poster design.

The Drawing Canvas
By default, the drawing tools draw over the top of existing text and diagrams. In Microsoft Word, however,
you can compose a drawing in a separate region, known as the Drawing Canvas. To do this (in Word):
1. Before you start your drawing, move to the INSERT tab, click on [Shapes] and choose New Drawing
Canvas - an area appears in which you make your drawing
2. Increase the size of the canvas, if necessary, by dragging on the side/corner handles
3. When you have completed your drawing, again drag in the handles to cut off any blank areas
4. To resize the canvas, right click on the edge and choose Scale Drawing - you can now use the handles
to enlarge (or shrink) the whole drawing (as opposed to extend the canvas)
You can also set up Word so that a drawing canvas is always used (though it’s not recommended):
1. For Word only, move to the FILE tab and choose Options
2. Move to the Advanced tab and under Editing options at the top, turn on Automatically create
drawing canvas when inserting AutoShapes
3. Press <Esc> to [Cancel] this (or <Enter> for [OK] , if you want this to always happen)
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